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Preface

Welcome to the Oracle Order Capture, Release 11i, suite of applications.

This Concepts and Procedures provides information and instructions to help you 
work effectively with Oracle Order Capture.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Technical Service Representatives (TSR)

■ Customer Service Representatives (CSR)

■ System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.

3. Basic understanding of Oracle and Developer/2000.

4. Background in SQL, PL/SQL, SQL* Plus programming.
ix



Structure
This manual contains the following chapters: 

“Understanding Oracle Order Capture“provides overviews of the application and 
its components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications.

“Using Oracle Order Capture” provides process-oriented, task-based procedures for 
using the application to perform essential business tasks. 

Related Documents
For more information, see the following manuals:

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Components Installation Guide

■ Oracle CRM Foundation Components Technical Reference Manual

■ Oracle Order Capture Installation Guide

■ Oracle Order Capture Technical Reference Manual 
x



Understanding Oracle Order Capture

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

Customers You Can Sell To: Consumers and Businesses
When you create a new customer and book an order for that customer, Oracle Order 
Capture automatically assigns an account number to the customer. 

You can sell to two types of customers: 

■ Consumers

■ Businesses

Consumers are individuals who are not purchasing on behalf of an organization. A 
consumer can have multiple addresses and phone numbers. For example, a 
consumer can have a home address and multiple shipping addresses for vacation 
homes, friends, and relatives. Because consumers are not affiliated with any 
organization, you cannot enter an organization when you create new consumer 
customer records.

A business customer represents an organization. Any individual at an organization 
can be your business customer. This includes a subsidiary or a branch of a company, 
an association, a church, or a government branch. An organization can have 
multiple contacts and addresses. See About Organizations.
Understanding Oracle Order Capture 1



About Organizations
About Organizations
An organization may be a company, an association, a church or a government 
branch. 

Here is a brief introduction to how the organization model works:

■ Each organization must have a name and a primary address. 

■ Each organization can have multiple addresses and multiple contacts associated 
with it.

■ Each time you add a contact for the organization with a new business address, 
that address automatically becomes a new address for the organization. 

■ Each time you enter a contact with a new business phone number, that phone 
number automatically becomes one of the organization’s phone numbers. 

■ You can enter optional information about an organization, including the 
number of employees, its revenue, business and tax codes.

Understanding Quotes
A quote is an offer to a customer that presents a variety of different pricing 
scenarios. You create a quote automatically when you accumulate items in the 
shopping cart for a customer and click the Save Quote button.

The application automatically assigns a number to the quote. This number appears 
in the Quote # field of the Contact Information region. The quote number is 
composed of the quote number itself and a version number that increments each 
time you create a new quote version.

As you work on a quote, you indicate its progress by changing the Status. Quote 
status tells others in your group how the negotiations with the customer are 
progressing. It also determines what kind of changes you and anyone else working 
with you can make to the quote. 

For example, if a quote is in the draft stage, then any changes you make simply 
overwrite your previous entries. If the quote status is bid, each time you save a 
modified quote, the application creates a new version for you. If the status is 

Note: You cannot create organizations within Order Capture. If 
you create a customer and need to create a new organization, then 
you must create the organization in another application. 
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Understanding Quote Status
ordered, then you cannot change the quote at all. See Understanding Quote Status 
for more details.   

Oracle Order Capture keeps a list of all of the quotes you have created, but you can 
only view and modify the latest version of a quote. You cannot delete quotes once 
you create them. Your administrator can set quotes to automatically expire after a 
certain period of time. 

Understanding Orders
Book an order after a customer has decided to make a purchase. If the customer has 
paid with a credit card, then Order Capture automatically obtains a credit card 
authorization. 

When you book an order, Order Capture passes the order to Oracle Order 
Management, an application that determines how the order is filled and shipped. 
Order Capture then gives you a confirmation number and estimates shippings costs 
and taxes. Use Order Management to track shipping costs and to verify that an 
order has been shipped. 

When you book an order in Order Capture for items that are out of stock, Order 
Management places these items on back order and determines when and how the 
items are shipped.

For example, a customer wishes to purchase ten items. Only seven are in stock; the 
other three are expected to be available in one month.The partial order flag in Order 
Management determines whether your customer receives the partial order of the 
seven available items immediately or whether the whole order is shipped in one 
month when the whole quantity becomes available. 

Use Order Capture to update and modify quotes, not orders. If you need to make 
changes to an order after you book it, then you must use Order Management. 

You can access some of the Order Management windows through the Customer 
History window in Order Capture. See Viewing and Modifying Customer Orders.

Understanding Quote Status
The status of a quote indicates its progress as it goes from the initial offer through a 
sequence of events until the order is placed. When a quote is initially created, it has 
a status of drafted; when the quote is completed it is passed on to Order entry, it has 
a status of ordered. 
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Understanding Quote Status
This topic covers:

■ Quote Status Determines Activity

■ Pre-defined Statuses

■ Rules for Status Changes

Quote Status Determines Activity
The status of a quote determines what kind of activities related to that quote are 
possible.

You can modify a quote only if it does not have a status of ordered.

If you save changes to a quote with the status of drafted, you overwrite the 
previous quote.

If you save changes to a quote with the status of bid, a new version of the quote is 
created automatically.

The status of the quote can limit how you can modify the quote statuses. For 
example, if a quote has a status of ordered, you cannot change the status to drafted. 

Pre-defined Statuses
By default, the following quote statuses are available:

■ Drafted: Initial status.

■ Bid: Presented to customer.

■ Accepted: Customer accepted terms.

■ Order Problem: There is a problem with placing the order.

■ Order Reviewed: The order has been reviewed for conformance to Order Entry 
rules and processes.

■ Ordered: The order has been sent on to Order Entry for processing.

■ Lost: The quotation has not been accepted by the customer.

■ Inactive: No more activity on this quotation.

Rules for Status Changes
Status changes are regulated to prevent accidental changes, such as reverting a 
quote status back to a non-ordered status.
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Understanding the Order Capture Window
The following table shows the suggested rules for quote status changes. The vertical 
columns shows the different statuses. The horizontal row shows the permissible 
status changes.   

For example, a quote with the status of accepted can only be changed to order 
problem, order reviewed, lost, or inactive. A quote with the status of ordered can 
only be changed to the status of lost or inactive. 
 

Understanding the Order Capture Window
Use the Order Capture window to:

■ Check on the availability of items in inventory

■ Explore various pricing alternatives with your customers

■ Create quotes

■ Place orders

■ Review and modify quotes you have prepared in the past

The Order Capture window is divided into five separate regions:

Suggested Permissible Quote Status Changes for Each Quote Status

From/To Drafted Bid Accepted
Order
Problem

Order
Reviewed Ordered Lost Inactive

Drafted No Yes Yes Yes Yes No Yes Yes

Bid No No Yes Yes Yes No Yes Yes

Accepted No No No Yes Yes No Yes Yes

Order Problem No No No No Yes No Yes Yes

Order Reviewed No No No No No Yes Yes Yes

Ordered No No No No No No Yes Yes

Lost No No No No No No No Yes

Inactive No No No No No No No No

Region Description

1 Basic contact and quote information.

2 Item view tab and shopping cart.
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Contact Information Region: Basic Contact and Quote Information
See Also
Customers You Can Sell To: Consumers and Businesses

About Organizations

Understanding Quotes

Understanding Orders

Understanding Quote Status 

Types of Items You Can Price and Quote 

How Items are Priced and Discounted 

Related Items: Cross-Sell, Upsell, and Substitute 

How a Customer Can Pay for an Order 

Contact Information Region: Basic Contact and Quote Information
The Contact Information region displays:

■ Basic information about the customer who is placing the order. Click Details to 
obtain additional information, such as the name, address, and organization.

■ The campaign associated with the whole order. 

■ Quote information, such as the quote number, version, and status. A quote is 
automatically created each time you start adding items to the shopping cart. 

In the Contact Information region, you can use the list of values for each field to 
make changes. For example, you can select a campaign for the order, or select 
another customer for the order by using the values in the Account, Name and 
Phone fields. 

To modify and add customer information, such as the shipping and billing 
addresses, click Details to open another window. See Entering an Existing 
Customer in the Order Capture Window for details.

3 Address and payment information.

4 Total order price and discount.

5 Buttons that create a quote version or an order.

Region Description
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Item View and Shopping Cart View
Item View and Shopping Cart View
The central portion of the Order Capture window includes two tabs: 

■ Item View

■ Shopping Cart View

Item View Tab
In this tab you:

■ View basic information and prices of items your customer may be interested in 
purchasing. See Pricing an Item for details.

■ View the availability of an item, by checking the Available Qty field.

■ View and modify the quantity or the price of an item. See Adjusting Prices of an 
Item in a Quote for details.

Items in Shopping Cart Panel

The Items in the Shopping cart panel at the top of the tab tells you:

■ If the item displayed in the Item View tab has been added to the shopping cart

■ How many items are in the shopping cart or quote

The left field indicates the position of an item in the cart or quote. 

If the left field is blank, then no item has not been added to the 
cart. The Item View tab is ready to receive a new item.

The right field tells the total number of items in the quote or cart. 

A blank right field means the shopping cart is empty.
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Item View and Shopping Cart View
You can use arrow buttons to scroll through the items in a quote and to create a new 
item in the quote.

Here is how the controls work:

If the Item View tab displays an item, a blank field on the left and 
a number on the right means that the item you are viewing has 
not yet been added to the shopping cart or quote. 
Click Add to Cart to add this item to the cart, or select another 
item.

If the Item View tab does not display an item and the left panel is 
blank, you can enter a new item.

In this example, the shopping cart has two items in it.

Numbers in both fields indicate that you are viewing an item that 
has been added to the shopping cart or is a line item in a quote. In 
this example, the Item View tab displays the second of five items 
in the shopping cart.

You can modify this item or click Remove to remove it from the 
cart or quote.

You can use the arrow keys on the panel to navigate to other 
items in the cart.

If you wish to view an item from the inventory that is not yet in 
the cart, then you must ready the cart first. You can do this by 
clicking the Add Record button in the toolbar (this is the button 
with a green plus sign).

Button Function

Go to the next item in the cart or quote. If you are viewing the 
last item in the quote, clicking this button creates a new item in 
the cart or quote. 

Go to the previous item in the cart or quote.

Go to the first item in the cart or quote.

Go to the last item in the cart or quote.
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Order Total
You can also view information about any substitute, upsell, or cross-sell items 
linked to the item by clicking Related Items. This button is disabled if there are no 
related items.

You can choose an extended warranty for the item displayed by clicking View 
Warranty.

Shopping Cart View Tab
Shopping Cart View tab lists the contents of your shopping cart or the quote you 
have created. You cannot make any changes here.

You must go to the Item View tab to view item details and modify the contents of 
the shopping cart.

Address and Payment Information
This region consists of two views:

■ Address

■ Payment 

You can switch between these views by making a selection from the View Order 
drop-down list.

Address
The address view displays the billing and shipping addresses for the order as a 
whole.

Payment
Use this tab to enter payment information for the order as a whole. 

If the customer wants to pay for an item separately, then you must use the 
procedure outlined in Paying for an Item in an Order Separately. 

Order Total
The order total region shows the total order price. This includes discounts, taxes, 
and shipping. Note that the tax and shipping amounts are estimates only. To obtain 
Understanding Oracle Order Capture 9



Save Quote and Book Order Buttons
exact shipment and tax amounts for an order, you must use Oracle Order 
Management after you book the order.

All fields are read-only. You cannot make any adjustments here.

Save Quote and Book Order Buttons
Save Quote saves a quote based on the items added to the shopping cart. Create a 
quote when a customer is not ready to make a purchase or to present a customer 
with different pricing scenarios.

Book Order books the order and sends the information to Oracle Order 
Management for processing. Use this button if your customer is ready to make a 
purchase. You receive a confirmation number. 

Types of Items You Can Price and Quote 
There are three types of items you can quote:

■ Standard items: These are items your customer can purchase on their own. The 
Item Type field displays "Standard".

■ Model items: These are items that come with different options your customer 
can choose from before purchase. A configurable item displays "Model" in the 
Item Type field. When you enter a configurable item into the Item View tab, 
then you see only the price of the most basic model. You can add different 
options to the base model after you add the basic model to the shopping cart.

■ Service items: These are items such as service contracts, installations, and labor. 
Service items have a start date and an end date and are measured in units of 
time. You must make entries in the Start Date, End Date, and Period fields when 
entering service items. 
10 Oracle Order Capture Concepts and Procedures



How Items are Priced and Discounted
How Items are Priced and Discounted
The price your customer pays for an item depends on price lists and campaigns you 
enter.

This topic covers:

■ Price lists

■ Discounts

■ Pricing adjustments

■ When items in an order are priced

Price Lists
The list price of an item comes from a price list. Your company can have many 
different price lists. For example, there may be a price list for a consumer and a 
corporate price list for corporate customers who receive an automatic discount 
because they buy from your company in bulk. You may have yet another price list 
for a customer that has a special contractual arrangement with your organization.

You can select a price list for the order as a whole and for each individual item. 
Selecting a price list for an item supersedes the price list you select for the whole 
order. 

Discounts
Depending on your configuration, the application either combines the two 
discounts or chains them. 

By default, discounts are chained. The applications first applies the order-level 
discount and then the line-level discount. The customer who purchasing the $100 
winter coat in our example pays $40. Here is how the price is calculated.

■ Apply the order-level campaign: $100 - 20%= $80

■ Apply the line-level campaign: $80 - 50%= $40

Pricing Adjustments
The application is set up to automatically calculate the best price for the customer 
based on the price lists for the order as a whole and for individual items.
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Related Items: Cross-Sell, Upsell, and Substitute
In future releases, you will be able to turn on or off individual discounts that make 
up a campaign and to create additional discounts of your own. 

When Items in an Order Are Priced
Each time you change the quantity of an item, the units of measure, or the 
campaign, the whole order is repriced automatically. This is because a change in one 
item can effect the level of other offers and discounts. 

Related Items: Cross-Sell, Upsell, and Substitute
There are three kinds of related items you can sell when the Related Items button is 
enabled in the Item View tab of the Order Capture window:

■  A cross-sell item is an item that you can sell as an addition to the item currently 
on display. 

■ An upsell item is a more expensive model you can substitute for the current 
item. 

■ A substitute item is an item you can substitute for an item that is not currently 
available.

How a Customer Can Pay for an Order
This topic discusses:

■ Payment for an Order

■ About Paying for Individual Items Separately

Payment for an Order
Customers can pay for an order by:

■ Cash

■ Check

■ Credit card

■ Purchase order

Payment can be of three types:
12 Oracle Order Capture Concepts and Procedures



About the Address Details Window
■ Single: if your customer is making a single payment using any payment 
method: cash, check, credit card, or purchase order. 

■ Installment: if your customer is paying in installments using any payment 
method.

■ Split: if your customer is paying for the order using multiple credit cards. 
You cannot split payment made by cash, check, or purchase order.

You enter payment information for the order in the Payment region of the Order 
Capture window. You must select Payment from the View Order drop-down list to 
view this region.

About Paying for Individual Items Separately
Your customer can choose to pay for some or all of the individual items that make 
up an order separately. For example, a customer may purchase office equipment 
intended for the home office using a business credit card and gifts for family 
members using a personal credit card.

If your customer chooses to pay for an individual item separately, then you enter 
payment information for that item in the Ship/Payment Detail window which is 
available by selecting Ship/Payment from the Action menu. The amount 
corresponding to the individual item is automatically deducted from the payment 
amount of the order as a whole.

For example. Joan Smith wants to purchase three items: a laptop computer for 
$1,500 and two $100 cellular phones. The total order price is $1,700. 

She wishes to pay for the order using her corporate credit card. But, as one of the 
cellular phones is for personal use, she wishes to pay for it on a personal credit card. 

In this case, you enter the business credit card information in the Payment region 
and the personal credit card in the Ship/Payment Detail window. The personal 
credit card is charged $100 for the single cell phone and that amount is 
automatically deducted from the total amount charged to the business credit card. 

About the Address Details Window
Use this window to display address details.
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Using the Order Capture Window
Using Oracle Order Capture

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Using the Order Capture Window
Use the Order Capture window for the following tasks:

■ Searching

■ Working with the shopping cart

■ Adjusting prices

■ Quoting

■ Entering payment information

■ Entering shipping information

■ Creating an order

For an overview of the function and layout of the Order Capture window see 
Understanding the Order Capture Window.

Searching
In Release 11.5.1 you cannot use the search button in the toolbar to search for items 
or customers. 

You can, instead, search in one of two ways:

■ Search on individual fields using the list of values provided in many fields.

■ Search using multiple criteria using the query method. 
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Searching
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Working with the Shopping Cart
Working with the Shopping Cart
Use the following procedures to view items and operate the shopping cart:

■ Viewing the List of Items in the Shopping Cart or Quote

■ Scrolling Through the Items in the Shopping Cart

■ Determining Whether an Item Has Been Added to the Shopping Cart

■ Entering an Item into the Item View Tab 

■ Clearing an Item from the Item View Tab 

■ Deleting an Item from the Shopping Cart or Quote 

■ Pricing an Item 

■ Pricing Configurable Items 

■  Adding Items to the Shopping Cart for a Quote or Order 

■ Adding a Service to the Shopping Cart 

■ Removing Items from the Shopping Cart or Quote 

■ Configuring an Item 

■ Cross-Selling, Upselling, and Substituting Items 

■ Finding Out When an Item Will Be Available 

Adjusting Prices
You can adjust prices of: 

■ The quote as a whole

■ An individual item in the quote

Quoting
Use these procedures to create and manipulate quotes:

■ Creating a Quote

■ Displaying a Quote

■ Modifying a Quote and Creating a New Version

■ Viewing the History of a Quote
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Searching Using the Query Method
■ Viewing Customer History

■ Viewing Customer Quotes

■ Finding a Customer Quote

Entering Payment Information
Use these procedures to enter payment for an order:

■ Paying for an Order Using a Single Payment Method

■ Paying for an Order Using Multiple Credit Cards

■ Paying for an Order by Installment

Entering Shipping Information
Use these procedures to enter shipping information:

■ Entering the Shipping Address for an Order

■ Shipping an Item to Alternate Destinations

Searching Using the Query Method
Use this method for searching for customers or addresses in the Order Capture. 
This general method of searching can also be used in other application windows.

Prerequisites
None.

Steps
1. Place your cursor in one of the fields in the region you wish to search.

2. From the View menu, choose Query by Example > Enter

The fields you can search turn blue.

3. Make an entry or a partial in one or more fields. You can use a wild card. For 
example, if you enter F%, the application returns all entries starting with the 
letter F.

4. From the View menu, choose Query by Example > Run.
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Entering an Existing Customer in the Order Capture Window
The application displays a matching entry, if any.

5. Check the status bar to see how many matching entries were found. If the 
application found more than one matching entry, then click your cursor in any 
field and use the down arrow on your keyboard to scroll through. 

Entering an Existing Customer in the Order Capture Window
Use this procedure to find and enter a customer in the Contact information region 
of the Order Capture window. For entering new customers see Entering a New 
Customer.

Prerequisites
The customer must exist in the database.

Steps
1. Navigate to the Order Capture Window.

2. If a customer is already displayed in the Contact Information region, then: 

a. Place your cursor in either the last or first name fields.

b. Click New Record in the toolbar. This is the button with a green plus sign.

A dialog box appears asking you if you wish to save your changes. 

c. Save or cancel any changes you have made by clicking the appropriate 
button.

 The Contact Information region clears.

3. If you know the account number for your customer, then:

a. Enter the account using the Account list of values (LOV).

If the customer is a consumer, then the customer’s name appears 
automatically. The Organization field remains blank.

If the customer is a business contact, then the Organization name appears 
automatically.

b.  If the customer is a business contact and the organization and no contact 
name appears automatically, then select the correct contact using the Last 
Name LOV.

4. If the customer is a business customer and you do not know the account 
number, then:
18 Oracle Order Capture Concepts and Procedures



Scrolling Through the Items in the Shopping Cart
a. Use the Organization LOV to enter the customer’s organization.

Selecting an organization restricts the names displayed in the first name 
and last name LOVs to contacts at that organization.

b. Use the Last Name LOV to enter the customer’s last name.

5. If the customer is a consumer and you do not know that customer’s account 
number, then:

a. Use the Last Name LOV to enter the customer’s name.

b. If the name is a common name and the list of names in the LOV is too long, 
then use the query method to search on the name and partial phone 
number. 

Viewing the List of Items in the Shopping Cart or Quote
Use this procedure to view a list of items in the shopping cart.

Prerequisites
An item must be added to the shopping cart before it appears in the list.

Steps
1. Click on the Shopping Cart View tab.

The list of items in the list displays. 

2. If you wish to view the details of an item in the list, then: 

a. Note the item’s position in the list.

b. Select the Item View tab and scroll to the item.

Scrolling Through the Items in the Shopping Cart
Use this procedure to scroll through the items in the shopping cart. 

Prerequisites
None.

Steps
1. Navigate to the Item View tab of the Order Capture window.
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Determining Whether an Item Has Been Added to the Shopping Cart
2. If the tab displays an item, check to see if you are viewing the item in the 
shopping cart.

3. If the tab displays an item that has not been added to the shopping cart, then, 
before you can view the shopping cart, you must either:

■ Clear it by clicking Clear.

■ Add it to the shopping cart by clicking Add to Cart.

4. Click the appropriate button to scroll through the shopping cart:

Determining Whether an Item Has Been Added to the Shopping Cart
Use this procedure to tell if the item displayed in the Item View tab has been added 
to the shopping cart.

Prerequisites
The Item View tab displays an item.

Steps
1. Navigate to the Item View tab of the shopping cart.

2. Check if the Items in the Shopping Cart panel displays a number in both 
numerical fields.

Button Function

Go to the next item in the cart or quote. If you are viewing the 
last item in the quote, clicking this button creates a new item in 
the cart or quote. 

Go to the previous item in the cart or quote.

Go to the first item in the cart or quote.

Go to the last item in the cart or quote.
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Clearing an Item from the Item View Tab
■ A number in both fields indicates you are viewing an item already in the 
shopping cart.

For example:

■ A number in only the right field indicates the item displayed has not yet 
been added to the cart.

For example:

 

Entering an Item into the Item View Tab
Use this procedure to enter an item into the Item View tab.

Prerequisites
You must know at least a portion of the inventory number of the item to enter an 
item.

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.

3. If the Item View tab already displays an item, then click New Record in the 
toolbar. This is the button with a green plus sign.

4. Use the list of values (LOV) to enter the item.

The item displays in the tab. You are now ready to add the item to the cart.

Clearing an Item from the Item View Tab
Use this procedure to remove from the Item View tab an item that has not yet been 
added to the shopping cart.
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Deleting an Item from the Shopping Cart or Quote
Prerequisites
None.

Steps
1. Navigate to the Item View tab.

2. Check to see if the item displayed has been added to the shopping cart.

3. If the item displayed has not yet been added to the shopping cart, then click 
Clear.

Deleting an Item from the Shopping Cart or Quote
Use this procedure to remove an item from the shopping cart or a quote.

Prerequisites
Items in the shopping cart.

Steps
1. Navigate to the Item View tab.

2. Check to make sure you are viewing the contents of the shopping cart.

3. If the Item View tab displays an item not in the shopping cart, then clear it by 
clicking Clear.

4. If the shopping cart contains multiple items, then use the arrow buttons to 
display the item you wish to delete. 

5. With the item to be deleted displayed in the Item View tab, click Remove.

Pricing an Item
Use this procedure to price an item in the Item View tab.

Prerequisites
■ You must know at least a portion of the inventory number of the item to enter 

an item. 

■ You must also know what price list or lists to which the item belongs.
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Pricing Configurable Items
Steps 
1. Enter the item into the Item View tab.

2. Enter the quantity in the Qty field. 

3. If the Item Type is model, then you must view its price following the procedure 
outlined in Pricing Configured Items.

4. If the Item Type is service, then:

a. Use the Period list of values (LOV) to enter the units for this service item.

b. Enter either the start and end dates for the service or the start date and 
duration.

The item pricing appears. The Unit Price shows the list price of this item 
from the price list shown in the Price List field.

5. If the Related Items button is enabled, then you can view and select upsell, 
cross-sell, and substitute items.

6. If your customer is not interested in purchasing the item, then click Clear to 
clear the Item View tab and be ready to view another item.

7. If you wish to add this item into the shopping cart, then click Add To Cart.

You are now ready to:

■ View an item or add another item to the shopping cart using this same 
procedure

■ Create a quote

■ Adjust prices

■ Enter payment information

Pricing Configurable Items
Use this procedure to price configurable items. These are items you must configure 
before pricing because their price depends on the options your customer chooses. 
Configurable items are items of item type model. 

Prerequisites
The Item View tab must display an item of Item Type Model. 
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Adding Items to the Shopping Cart for a Quote or Order
Steps
1. Click Add to Cart to add the model item into the shopping cart.

2. The Item View tab displays the model item. This is usually the most basic 
configuration

3. Configure the item. 

4. Navigate back to the model you entered originally to view the total price of the 
item and its options. 

5. If your customer decides not to purchase the item after you have configured it, 
then you must remove the item.(The components are removed automatically.)

See Removing Items from the Shopping Cart for instructions.

Adding Items to the Shopping Cart for a Quote or Order
Use this procedure to add items to the shopping cart. The procedure is the same 
whether you are creating a quote or an order.

Prerequisites
Your customer must be displayed in the Contact Information region of the Order 
Capture window.

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.

3. If the Item View tab already displays an item, then click New Record in the 
toolbar. This is the button with a green plus sign.

4. If the Item View tab is blank, then use the list of values (LOV) to enter the item.

The item displays in the tab. 

5. Enter the quantity in the Qty field. 

6. If the Item Type is model, then the item is a configurable item. The item 
displayed is only the base model. You can configure this item to add more 
options.

7. If the Item Type is service, then:
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Adding a Service to the Shopping Cart
The item pricing appears. The Unit Price shows the list price of this item from 
the price list shown in the Price List field.

8. If the Related Items button is enabled, then you can view and select upsell, 
cross-sell, and substitute items.

9. If you wish to add this item into the shopping cart, then click Add To Cart.

10. Repeat this procedure to add other items to the shopping cart.

11. When you are done you are ready to:

■ Create a quote

■ Book an order.

Adding a Service to the Shopping Cart
Use this procedure to enter a service for an item in a quote or order. The procedure 
is the same whether you are creating a quote or an order.

Prerequisites
■ Your customer must be displayed in the Contact Information region of the 

Order Capture window.

■ You must enter a service against an item already in the database. The item can 
be in a quote, order, or the customer’s installed base of products. You cannot 
purchase a service on its own. 

Steps 
1. Navigate to the Item View tab.

2. Place your cursor in the Item field.

3. If the Item View tab already displays an item, then click New Record in the 
toolbar. This is the button with a green plus sign.

4. If the Item View tab is blank, then use the list of values (LOV) to enter the item.

The item displays in the tab. 

5. Enter either the start date and the end date for the service or the start date and 
the period. 

■ Entering a start date and end date automatically calculates the period.

■ Entering a start date and period automatically calculates the end date.
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Removing Items from the Shopping Cart or Quote
6. Click Add to Cart.

The Service Reference window appears.

7. Select the appropriate category from the Service For drop-down list:

■ Quote: if the service is for an item in a quote.

■ Order: if the service is for an item in an order.

■ Installed Product: if the service is for an item in a product already installed 
at a customer site.

8. If the service is for a quote item, then use the Reference Number LOV to enter 
the line number of the item. The reference number is a concatenation of the 
quote number and the line number of the item.

9. If the service is for an order item, then use the Reference Number LOV to enter 
the line number of the item. The reference number is a concatenation of the 
order number and the line number of the item.

10. If the service is for an item that is already installed at a client site, then enter the 
serial number of the item.

11. Click OK to save and close the Service Reference window and return to the 
Order Capture Window.

The Service item is added to the cart at this point.

12. If the Related Items button is enabled, then you can view and select upsell, 
cross-sell, and substitute items.

13. Repeat this procedure to add other items to the shopping cart.

14. When you are done you are ready to:

■ Create a quote

■ Book an order.

Removing Items from the Shopping Cart or Quote
Use this procedure to remove items from the shopping cart or quote.

Prerequisites
None.
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Cross-Selling, Upselling, and Substituting Items
Steps
1. If you are removing items from a quote, then you must display the quote in the 

Order Capture window.

2. Using the Items in Shopping Cart panel buttons located on the Item View tab, 
navigate to the item you wish to remove from the cart.

3. Click Remove.

Configuring an Item
Use this procedure to configure a configurable item.

Prerequisites
■ The item in the Item View tab must be of type Model.

■ The item you wish to configure must be added to the shopping cart.

Steps
1. Display the item you wish to configure in the Item View tab.

2. From the Tools menu, choose Configure Item.

The Oracle Configurator window appears.

3. In the left hand pane of the window, select the category of option you wish to 
add to the base item.

4. The items in the category and their descriptions appear in the top right hand 
pane.

5. Select the item(s) you wish to add to the shopping cart by clicking the check 
boxes to the left of each item. 

6. Click Done.

The items you selected are added to the shopping cart. 

Cross-Selling, Upselling, and Substituting Items
Use this procedure to sell a substitute, a cross-sell, or up-sell item to your customer. 
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Cross-Selling, Upselling, and Substituting Items
Prerequisites
■ The item you wish to cross-sell, upsell, or replace with a substitute must be 

added to the shopping cart and displayed in the Item View tab. 

■ The Related Items button must be enabled, indicating that related items have 
been set up for this product.

Steps
1. Click Related Items in the Item View tab.

The Related Items window appears.

2. To add one or more related items to the cart:

a. Click on one item in the list.

b. Click Select Items.

c. Repeat the procedure for other items, if any.

3. When you are done selecting items, click OK to close the window and bring 
you back to the Order Capture window.

The first item you selected in the Related Items window and its price is 
displayed in the Item View tab. 

4. If you selected more than one item in the Related Items window, then you can 
view the additional items and their prices by using the down arrow key on your 
keyboard.

5. Click Add to Cart for any item you wish to add to the cart.

Guidelines
Here is how choosing a related item changes the shopping cart:

■ Adding an upsell item replaces the item in the shopping cart. If you add several 
upsell items into the cart, only the last one is added to the cart.

■ Adding a cross-sell item, adds the item to the cart. You can select multiple 
cross-sell items to add to the cart.

■ Adding a substitute item, replaces the item in the shopping cart. If you add 
several substitute items into the cart, only the last one is added to the cart.

See Related Items: Cross-Sell, Upsell, and Substitute.
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Viewing Discounts
Adjusting Prices of an Item in a Quote
Use this procedure to adjust the price of an item for your customer.

Prerequisites
The item and its price must be displayed in the Item View Tab.

Steps
You can modify prices for an individual item in your order by:

■ Selecting a different price list from the Price List list of values (LOV). 
Different price lists can price the item differently. 

Adjusting Prices for a Whole Quote
Use this procedure to adjust the price of a quote. If you wish to adjust prices for an 
individual item rather than for the quote as a whole, then see Adjusting Prices of an 
Item in a Quote.

Prerequisites
The quote you wish to adjust must be displayed in the Order Capture window.

Steps
You can modify prices for a whole quote by:

■ Selecting a different price list for the quote.

Viewing Discounts
Use this procedure to view discounts. You cannot make any modifications in this 
version of the application.

Prerequisites
The items in the shopping cart must be saved as a quote.

Note: Note that the LOV shows all of your price lists, even those 
that do not list the item price. If you select a price list that does not 
have a price for the item, then you will receive an error message.
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Selecting a Different Price List for a Quote
Steps
1. If you wish to view discounts for the order as a whole, then:

a. Place the cursor in any field in the Contact Information region.

b. From the Actions menu, choose Price Adjustments.

2. If you wish to view discounts for an individual item, then from the Actions 
menu, choose Price Adjustments.

The Price Adjustments window appears.

The window lists the adjustments that apply for this line or order. You cannot 
make any modifications.

3. Click OK to return to the main Order Capture window.

Selecting a Different Price List for a Quote
Use this procedure to change the price list for a quote.

Prerequisites
The quote must be displayed in the Order Capture window.

Steps
1. From the View Order drop-down list, select Payment.

2. Use the Price List list of value (LOV) to select a price list.

Creating a Quote
A quote holds the items your customer is interested in purchasing before you book 
an order. Use this procedure to create a quote.

Prerequisites
The customer must be displayed in the Contact Information region of the Order 
Capture window.

Steps
1. Add items to the shopping cart. 

2. Adjust discounts. This is an optional step. For instructions, see Adjusting Prices 
of an Item in a Quote and Adjusting Prices for a Whole Quote.
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Modifying a Quote and Creating a New Version
3. Click Save Quote. 

The application saves the quote under the number listed in the Quote # field in 
the Contact Information region.

Displaying a Quote
Use this procedure to display a quote you have created for a customer.

Prerequisites
The Contact Information region must display the customer associated with the 
quote.

Steps
1. From the Reports menu, choose Customer History.

The Customer History window appears.

2. In the Quotes tab, select the quote you wish to view.

3. Click Details.

The latest version of the quote displays in the Order Capture window.

Modifying a Quote and Creating a New Version
Use this procedure to modify an existing quote and create a new version. You can 
only modify the latest version of a quote.

Prerequisites
The Contact Information region must display the customer associated with the 
quote.

Steps
1. Display the quote.

2. Modify the quote by:

■ Adding new items

■ Changing the quantity

■ Adjusting prices
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Paying for an Order Using a Single Payment Method
■ Modifying customer information

■ Entering payment information

■ Entering shipping information

3. If required by your departmental procedures, change the status of the quote by 
selecting an appropriate status from the Status drop-down list. For example, 
when a customer approves a quote, then you can change the status of a quote 
from draft to approved. 

4. Click Save Quote.

Depending on the status of the quote, the changes you have made are saved in 
the version of the quote you are editing, or a new version is created for you. See 
Quote Status for more information.

Paying for an Order Using a Single Payment Method
Use this procedure to enter payment information if your customer wishes to pay for 
an order with a single payment method. 

If your customer has an agreement on regular payment and shipping terms with 
your organization, then follow an alternate procedure outlined in Using 
Agreements with Your Customer to Fill in Order Information.

Prerequisites
The Contact Information region must display the customer.

Steps
1. From the View Order drop-down list, choose Payment.

2. Select the Single radio button.

3. Select the payment terms using the Payment Terms list of values (LOV). 

4. From the Payment Type drop-down list, select the payment type.

5. If you have selected cash as the payment type, then click Save on the toolbar. 
You have completed this procedure.

6. If you have selected check as the payment type, then:

a. In the Number field, enter the check number.

b. Click Save on the toolbar. 
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Paying for an Order Using Multiple Credit Cards
7. If you have selected purchase order as the payment type, then:

a. In the Number field, enter the purchase order number.

b. Click Save on the toolbar. 

8. If you have selected credit card as the payment type, then:

a. From the Credit Card drop-down list, select the credit card type.

a. In the Number field, enter the credit card number.

b. Enter the expiration date.

c. Click Save on the toolbar. 

The application performs a credit card check and displays an approval 
code.

References
If your customer wishes to pay for an item separately, then follow the procedure for 
Paying for an Item in an Order Separately.

Paying for an Order Using Multiple Credit Cards
Use this procedure to enter payment information if your customer wishes to pay for 
the order using multiple credit cards. If you choose this payment method, then your 
customer cannot pay for individual items in the order separately.

If your customer has an agreement on regular payment and shipping terms with 
your organization, then follow an alternate procedure outlined in Using 
Agreements with Your Customer to Fill in Order Information.

Prerequisites
The Contact Information region must display the customer.

Steps
1. From the View Order drop-down list, choose Payment.

2. Select the Split radio button.

3.  Enter credit card information for up to three credit cards. For each credit card:

a. Select the payment terms using the Payment Terms list of values (LOV)

b. From the Credit Card drop-down list, select the credit card type.
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Paying for an Order by Installment
a. In the Number field, enter the credit card number.

b. Enter the expiration date.

c. Enter the amount.

The combined amount must add up to the total order amount shown in the 
Total field.

4. Click Save on the toolbar. 

The application performs a credit card check for each card and displays an 
approval code.

References
If your customer wishes to pay for an item separately, then follow the procedure for 
Paying for an Item in an Order Separately.

Paying for an Order by Installment
Use this procedure to enter payment information if your customer wishes to pay for 
an order with a single payment method on an installment basis. If you choose this 
payment method, then your customer cannot pay for individual items in the order 
separately.

If your customer has an agreement on regular payment and shipping terms with 
your organization, then follow an alternate procedure outlined in Using 
Agreements with Your Customer to Fill in Order Information.

Prerequisites
The Contact Information region must display the customer.

Steps
1. From the View Order drop-down list, choose Payment.

2. Select the Installment radio button.

3. Select the payment terms using the Payment Terms list of values (LOV). 

4. From the Payment Type drop-down list, select the payment type.

5. If you have selected cash as the payment type, then click Save on the toolbar. 
You have completed this procedure.

6. If you have selected check as the payment type, then:
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Paying for an Item in an Order Separately
a. In the Number field, enter the check number.

b. Click Save on the toolbar. 

7. If you have selected purchase order as the payment type, then:

a. In the Number field, enter the purchase order number.

b. Click Save on the toolbar. 

8. If you have selected credit card as the payment type, then:

a. From the Credit Card drop-down list, select the credit card type.

a. In the Number field, enter the credit card number.

b. Enter the expiration date.

c. Click Save on the toolbar. 

The application performs a credit card check and displays an approval code.

Paying for an Item in an Order Separately
Use this procedure to set up separate payment for an item in an order.

Prerequisites
You must select the single payment method for the order as described in Paying for 
an Order Using a Single Payment Method.

Steps
1. Place the cursor in one of the fields in the Item View tab displaying the item to 

be paid for.

2. From the Action menu, choose Shipment/Payment Detail.

The Shipment/Payment window appears.

3. From the View drop-down list, choose Payment.

4. Select either the Single radio button, depending on the payment terms.

5. Select the payment terms using the Payment Terms list of values (LOV). 

6. From the Payment Type drop-down list, select the payment type.

7. If you have selected cash as the payment type, then click OK. You have 
completed this procedure.
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Entering the Billing Address for an Order
8. If you have selected check as the payment type, then:

a. In the Number field, enter the check number.

b. Click OK. 

9. If you have selected purchase order as the payment type, then:

a. In the Number field, enter the purchase order number.

b. Click OK. 

10. If you have selected credit card as the payment type, then:

a. From the Credit Card drop-down list, select the credit card type.

a. In the Number field, enter the credit card number.

b. Enter the expiration date.

c. Click OK. 

Entering the Billing Address for an Order
Use this procedure to enter a billing address for an order.

Prerequisites
■ The Contact Information region of the Order Capture window must display the 

customer.

■ The individual to be billed and the billing address must already exist in the 
database.

Steps
1. From the View Order drop-down list, select Addresses.

2. If no name appears in the Bill to Name field or you wish to bill a different 
individual, then use the Bill to Name list of values (LOV) to enter the correct 
name.

3. Use the Address LOV to select a billing address.

4. Click Save on the toolbar.
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Shipping an Item to Alternate Destinations
Entering the Shipping Address for an Order
Use this procedure to enter the shipping address for the order.

Prerequisites
The Contact Information region of the Order Capture window must display the 
customer.

Steps
1. From the View Order drop-down list, select Addresses.

2. If the correct billing address is displayed and the shipping address is the same, 
then check the Ship to Same Address check box. 

3. If the correct individual does not appear in the Ship To Name, then enter the 
individual using the list of values (LOV). 

4. If you wish to ship individual items to a different shipping address than the one 
you enter here, then follow the procedure outlined in Shipping an Item to 
Alternate Destinations.

5. Use the Address LOV to select a shipping address.

6. Click Save in the Toolbar.

Shipping an Item to Alternate Destinations
Use this procedure to ship an item to one or more address that are different from the 
shipping address for the order as a whole. 

Prerequisites
You must create a quote before carrying out this procedure.

Steps
1. Display the item you wish to ship to an alternate destination in the Item View 

tab.

2. Place the cursor in one of the field in the Item View tab.

3. From the Action menu, choose Shipment/Payment Detail.

The Shipment/Payment window appears.

4. From the View drop-down list, choose Shipping.
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Creating an Order
5. In the Qty field, enter the quantity you wish to send to the alternate address. 
You can specify a partial quantity or the whole quantity, depending on whether 
you wish to send an item to one or more shipping addresses.

6. Use the Ship To list of values (LOV) to enter the name of the individual to 
which you wish to ship the item.

7. Use the Address LOV to enter an address. 

8. Enter any shipping or packing instructions.

9. If you wish to ship another quantity of the same item to a different destination, 
then click Next and repeat the above procedure.

10. Click OK if you wish to save the new shipping address and return to the main 
Order Capture window.

Guidelines
You can use this procedure to ship quantities of an item to multiple locations. For 
example, a customer who is ordering 10 items, can ship 2 to one address, 3 to 
another, and five to another.

Creating an Order
Use this procedure to create an order directly from the Order Capture window or 
from a quote you have created. 

Prerequisites
None.

Steps
1. If you are creating an order from a quote, then display the quote in the Order 

Capture window.

2. If you wish to add items to the order then follow the procedure in Adding Items 
to the Shopping Cart for a Quote or Order.

3. Adjust discounts. This is an optional step. For instructions, see Adjusting Prices 
of an Item in a Quote and Adjusting Prices for a Whole Quote.

4. Enter payment information.

5. Enter shipping information.

6. Click Book Order.
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Viewing the History of a Quote
Your order is submitted to Oracle Order Management and you receive a 
confirmation number. You must track the order in Order Management to check 
on its status and to make sure that the order is filled and shipped. See Orders 
for more information.

Creating a Contract for an Order
Use this procedure to generate a contract from a quote. If you use this procedure, 
then you must not book this order with the Book Order button from Order Capture. 
Doing so creates a duplicate order.

Prerequisites
You must be using Oracle Contracts and have contracts set up in order to use this 
feature.

Steps
1. From the Action menu, choose Create Contract.

The Contracts window appears.

2. Select the contract template you wish to use for this order.

3. Click OK.

Order Capture forwards your order to Oracle Contracts. After a contract is 
created, Oracle Contracts sends it to Order Management for fulfillment. 

Viewing the History of a Quote
Use this procedure to view the history of the current quote. The quote history gives 
you basic information only. This includes the dates and times when previous 
versions of the quote were created as well as identity of the individual who created 
them. You cannot view the detailed pricing of the quote in this version of Order 
Capture.

Prerequisites
The quote must be displayed in the Order Capture window.

Steps
1. From the Reports menu, select Quote History.
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Viewing Customer History
The Quote History window appears listing basic information about this quote.

2. Click OK to close this window.

Viewing Customer History
You can use this window to:

■ View all the quotes for the current customer

■ Find a customer quote you wish to view or modify 

■ View the order history for a customer

Viewing Customer Quotes
Use this procedure to view the quotes prepared for this customer. 

Prerequisites
The customer must be displayed in the Order Capture window.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears.

2. Select the Quotes tab.

3. The tab lists all quotes for this customer. 

4. If you wish to view the details of a quote and modify it, then click Details.

The latest version of the quote displays in the Order Capture window. Whether 
you can modify a quote depends on its status. 

Not all quote statuses allow you to make modifications. A quote with a status of 
ordered has already been turned into an order and cannot be modified, for 
example. Modification permissions are set up by the application administrator. 

5. If you wish to create a new quote for this customer, then click New.
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Viewing and Modifying Customer Orders
Finding a Customer Quote
Use this procedure to find and display a quote to view and modify in the Order 
Capture window. 

Prerequisites
The customer must be displayed in the Order Capture window.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears.

2. Select the Quotes tab.

3. Select the quote you wish to view.

4. Click Details.

The latest version of the quote displays in the Order Capture window. Whether 
you can modify a quote depends on its status. 

Not all quote statuses allow you to make modifications. A quote with a status of 
ordered has already been turned into an order and cannot be modified, for 
example. Modification permissions are set up by the application administrator. 

Viewing and Modifying Customer Orders
Use this procedure to view orders placed by this customer with Order Management. 
This includes, but is not limited to, the orders booked through Order Capture. 

Prerequisites
The customer must be displayed in the Order Capture window.

Steps
1. From the Reports menu, select Customer History.

The Customer History window appears. 

2. Select the Orders tab.

3. If you wish to view the details of an order and modify it, then sect the order and 
click Details.
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Finding Out When an Item Will Be Available
The order information displays in an Order Management window. For 
instructions on how to use Order Management, consult the help system for that 
application.

4. If you wish to create a new order for this customer, then click New.

Finding Out When an Item Will Be Available
Use this procedure to find out when the desired quantity of an item will be 
available. You need to use this procedure only when the quantity available in the 
Qty field is less then the quantity desired by your customer. 

Prerequisites
The item must be displayed in the Item View tab of the shopping cart.

Steps
1. From the Actions menu, choose Availability - Item.

The Available Date field displays the date when all of the requested quantity 
will be available for shipping.

If you book the order, then your customer receives all of the currently available 
quantity. The balance is placed on back order and shipped on the available date.

2. Click OK.

The available date becomes the date filled in the Scheduled field of the Item 
View tab.

 Guidelines
Items are not reserved for your customer before you save the quote or successfully 
book the order. The point at which inventory items are reserved for your customer 
depends on the setting of system profile option OC:Reservation. By default, items 
are reserved when you save the quote. Contact the application administrator for 
details.
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Using the Shipment and Payment Window
Using Agreements with Your Customer to Fill in Order Information
Use this procedure to fill in agreement terms your company has set up with the 
customer. Agreements can include price lists, discounts, payment terms, and even 
ship to address.

Prerequisites
■ Your company must first set up agreements in Oracle Pricing.

■ Your customer must be displayed in the Order Capture window.

Steps
1. From the View Order drop-down list, select Payment.

2. Use the Agreement list of values (LOV) to select the agreement.

3. Continue with the creation of the quote or order.

Selecting a Warranty for an Item
Use this procedure to select an extended warranty for an item displayed in the Item 
View tab.

Prerequisites
The item must be added to the shopping cart and displayed in the Item View tab.

Steps
1. Click View Warranty.

The Warranties window appears.

2. Select the warranty in the list.

3. Click Add to Cart to add the warranty to the shopping cart and return to the 
main Order Capture window.

Using the Shipment and Payment Window
Use this window for:

■  Shipping an Item to Alternate Destinations

■  Paying for an Item in an Order Separately
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Entering Installation Details
Entering Installation Details
Use this procedure to enter installation details for serviceable items. Serviceable 
items are items for which your customer can purchase service agreements.

Prerequisites
The item must be added to the shopping cart and displayed in the Item View tab.

Steps
1. From the Action menu, choose Installation Details.

The Installation Details window appears.

2. In the Transaction tab, use the Transaction Type list of values (LOV) to select a 
transaction type. 

3. Enter a quantity.

4. If the item requires a new system to be created, then:

a. Click AutoCreate System.

The AutoCreate Systems window appears.

b. Enter the quantity.

c. Click OK.

5. Use the System LOV to enter a system.

6. Use the Contact LOVs to enter optional contacts for the installation. If necessary, 
you can create additional records for contacts by clicking New Record in the 
toolbar.

7. Use the Location LOV to enter a location where the item is to be installed.

8. If you have not selected New as the transaction type, then, on the Reference tab, 
enter a reference number.

9. Click Add.

10. Click OK.
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